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ᢝ  الإعــــــداد من الـــــــــــــــــــــدلᘭل هــذا ســــــــــــــــــــــᘭمكنك
ᡧᣚ  ،دقᘭقــــــــــــــــــة 15 غضــــــــون 

اء المسᙬشـــــــــــــــــــــــــــــــــــــــــارᗫن واســــــــــــــــتخدام ᢔᣂللتـــــــــــــــــــــــــداول الـــــــــــــــــــــــخ  ᢝᣑـــــــــــــــــــــــــــــار أو الـــــــــــــᘘالاخت 
 ᢝ

ᡧᣛالخلـــــــــــــــــــــــــــــ  ᢝ
ᡧᣚ اتᘭجᘭات اختᘘـــــــــــــــــــــــار أداة  ᡨᣂالإســــــــــــــــــــــــــــــــــــــــــــــــــــــــ MT5. 
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  EAبطلبات الويب السماح 

 خيارات > مستشارون خبراء (علامة تبويب)أدوات > >  MT5محطة 

  < 

 ، ثم اضغط على "موافق"." https://momentum-trend.com> اكتب "

 

 المستشارين الخبراءدليل 

 ) في هذا المجلد.EA> ضع مستشار الخبير (MQL5 > Experts > البياناتملف > فتح مجلد 

      

 " Ctrl+Shift+D>فتح مجلد البيانات "
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 MQL5مجلد >

 مجلد الخبراء>

 على الرسم البياني  EAتحميل 
 ; المستشارون الخبراءgtالملاح&; gt; عرض&MT5&gtمحطة 

 

 Navigatorمن  EA" > اسحب USDJPY، على سبيل المثال الآن ملف > مخطط جديد > "ابحث عن رمز المخطط الخاص بك
 SET> "أدخل كلمة المرور" (مطلوب) > انقر فوق تحميل > تحميل ملف  Allow Algo Tradingوأسقطه على المخطط > حدد 

usdjpy_m15  قم بتغيير الإطار الزمني للمخطط إلى <M15. 
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على مخطط،  EAملاحظة: في كل مرة تقوم فيها بتحميل 
 ، على سبيل المثالجديدًا رقمًا سحريًايجب أن تمنحه 
56823798. 

 
علامة التبويب "المدخلات"؛ تأكد من أنه يوجد الرقم السحري في 

 أرقام على الأقل. 5يتكون من 
 .يجب أن يكون لكل مثيل من مستشار خبير رقم سحري جديد وفريد

حتى لا يكون هناك أي لبس بين الاستراتيجيات التي لها نفس الرمز، 
 ولكن ليس بالضرورة نفس الإعدادات. 

&gt اسحب ;EA  من المستكشف وأسقطه على الرسم
 البياني   .

 

&gt حدد ;]"    [Allow Algo Trading علامة) "
 ").Commonالتبويب "

 

 انقر على "تحميل"    .   

 
 

  قم بتحميل ملفSET  الخاص برمزك 
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  الآن قم بتغيير الإطار الزمني للرسم البياني ليتطابق مع اسم ملفSET ، على سبيل المثالusdjpy_m15 يجب وضعه ،
 gt; Timeframes &gt; M15. انقر بزر الماوس الأيمن على الرسم البياني &M15على الرسم البياني 

  إذا كان لديكEA  يرجى إسقاط . واحد مخططمستشار خبير يتداول رموزًا متعددة من  - متعدد الرموزEA  على مخطط
 . )M5(دقائق  5فوركس 

  إذا كنت تتداول بإعدادات محافظة، فضع ملفات الإعدادات على مخططH1 (1 (لأن الإطار الزمني الأدنى هو ساعة ،H1 
. 

 

 . (يرجى قراءة الدليل)SETملفات ع بعد الانتهاء من ذلك، يجب عليك الآن تغيير المخاطر في جمي
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 تغيير إعدادات المخاطر
 

 

 في كل صفقة. EAهو النسبة المئوية من رصيد الحساب التي سيخاطر بها "نسبة المخاطرة" إدخال 

الذهب/الدولار إذا كنت تتداول رمزًا واحداً فقط، مثل ويجب استخدامها فقط للمخاطرة المطلق  الأقصى٪ هي الحد 1.0=  1.0
 الأمريكي.

مرفقة)، فيجب أن يكون إدخال "نسبة المخاطرة" على جميع المخططات هو الحد  EAمخططات مع  5 رموز (أي 5 إذا كنت تتداول

  0.20، وهو ما يساوي 5 ÷٪1 الأقصى المطلق =

 .0.20"، نسبة المخاطرة = 0.20"ستكتب 

 سي الخاص بي.أنا أستخدم نصف ذلك فقط في مؤشر الإشارة الرئي

÷%1 = بالنسبة للعملات المشفرة، أستخدم مخاطرة كاملة تبلغ ، ولكن لدي إيداع أولي  (                 )

 غير المشفرة).( Darwinexأضعاف إيداعي لحسابي الرئيسي في  5أصغر، أي 

 

 . حسنًا، الآن يمكنك الاستمتاع بالتداول

 

 

 

 

 ؟الرسم البيانيلا يمكنك العثور على الرمز أو رمز السهم أو إضافة رموز إلى مراقبة السوق 
 

; انقر بزر الماوس MT5 Terminal &gt; View &gt; Market Watch…&gtإذا لم تتمكن من العثور على رمز الأسهم، 
 ، Market Watch &gt; Show Allالأيمن على أي رمز أسهم داخل 
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 تحصل على جميع الرموز المطلوبة، ارجع إلى "مراقبة السوق" > انقر بزر الماوس الأيمن على أي رمز > "إخفاء الكل".  بعد أن

 بهذه الطريقة، لن تعمل مراقبة السوق في الخلفية باستخدام موارد وحدة المعالجة المركزية، ولن تظهر لك أسعار الأسهم التي لا تهمك.

فروق العرض مراقبة السوق" > انقر بزر الماوس الأيمن على أي رمز > أعمدة > الفرق. يعرض جميع (أيضًا أثناء وجودك في "
 بالنقاط).والطلب 

 
 

 

 

 

 

 

 

 Windows Server VPSمع  EAكيفية إعداد 
 

Windows Server 2012/2019/2022 

 Windows 7 ،Windows Serverيشبه جهاز الكمبيوتر الذي يعمل بنظام  – Windows Server 2012ملخص: 
 .Windows 10يشبه جهاز الكمبيوتر الذي يعمل بنظام  – 2019/2022

 ForexVPS.net :https://www.forexvps.net/partner/retailtradingrealitiesعرض 
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 .ping، أسرع https://www.mql5.com/en/vpsبـ نوصي أيضًا 

 .Windows 10/11كما تفعل على جهاز كمبيوتر يعمل بنظام  MT5قم بتنزيل وتثبيت 

 

 انسخ إعداداتي:

MT5 Terminal > Tools > Options > Charts 

 

MT5 Terminal &gt; Tools&gt; Options &gt; Expert Advisors 

 

 > أدوات > خيارات > خادم MT5منصة 
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 > أدوات > خيارات > المجتمع MT5محطة 

 

 

 :VPSالخطوة الأخيرة في 

بمجرد أن تصبح جميع الرسوم البيانية والأطر الزمنية والرموز التي تريد استخدامها في العرض، انتقل إلى عرض > مراقبة السوق 
 "إخفاء الكل".انقر بزر الماوس الأيمن على أي رمز، وانقر على >  >

 . EAعن قراءة الأسعار في الخلفية من الرموز/الرموز التي لا يتداول عليها  MT5سيؤدي ذلك إلى إيقاف 
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MT4/5 AUTO START  لـVPS: 

 

، وهم يوفرون هذه الميزة، ForexVPS.netنستخدم  Retail Trading Realitiesنحن في 
تلقائياً في كل  MT4/5الخاص بهم لبدء تشغيل جميع محطات  exeحيث يمكنك استخدام برنامج .

مرة يتم فيها إعادة تشغيل الخادم. تذكر أنه سيتعين عليك إعادة تشغيل الخادم من حين لآخر، ولكن 
 خوادم للصيانة.الخاص بك سيقوم أيضًا بإعادة تشغيل ال VPSمزود 

 
 ODTسيتعين عليك تمكين هذه الميزة يدوياً من خلال قراءة الخطوات الواردة في ملف نصي .

 (عادةً ما يكون موجودًا على سطح المكتب).
 

 الأخرى لخدمات الفوركس هذه الميزة أيضًا (جميعها تقريباً). VPSتوفر شركات 
 

 .MQL5.comمن  MetaQuotesقدم من لن تحتاج إلى القيام بذلك إذا كان لديك خادم م
 

 .MT4/5مع  Linuxلا تستخدم خادم 
 

 

 

 

 

 

 ما هو؟ – MT5اختبار الاستراتيجية والمحسّن في 
 

 > عرض > مختبر الاستراتيجية MT5محطة 
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 . MT5لاختبار مستشار خبير، يمكنك تشغيل اختبارات فردية وتحسينات في أداة اختبار الإستراتيجية في 

ستفحص التحسينات المعلمات المدخلة (انظر علامة التبويب "المدخلات" في "الخبير") التي حددتها وجميع القيم التي تريد اختبار 
مدخلات فقط للتحسين.  3المستشار الخبير عليها. ستختبر جميع التركيبات الممكنة للإعدادات. كن حذرًا، يوصى باختيار ما يصل إلى 

 لات المحددة، زادت فرصة "ملاءمة المنحنى". كلما زاد عدد المدخ

إلى "الخوارزمية  MT5تركيبة، فسيعود  2000إذا اخترت عدداً كبيرًا جداً من المدخلات وإعدادات الخطوات، على سبيل المثال 
ت باستخدام الجينية" للعثور على أفضل الإعدادات، ولن يختبر كل تركيبة. سيختبر عينة ويحاول العثور على أفضل الإعدادا

 خوارزمية سرية داخلية.
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 اختر الرمز وفترة الرسم البياني التي كنت ستضع عليها المستشار الخبير، إذا كان التداول حقيقيًا. 

 . MT5مهم جداً للمستخدمين الجدد لمختبر استراتيجية  رمز الدولار الأصفر

ستحتاج إلى النقر فوق هذا الرمز لتغيير الإعدادات الافتراضية للرموز المحددة من أجل إجراء اختبار رجعي صحيح. الإعداد 
" أو CFD Leverageإلى "". هنا ستقوم بتغييره Forex No Leverage" و "CFDالافتراضي هو إما (بدون رافعة مالية) "

"Forex ." 

 

"، وهذا التغيير في الاتجاه Short Only" أو "Long only" إلى "Full Accessيمكنك أيضًا تغيير الاتجاه الافتراضي من "
 المحدد هنا سيعمل فقط للاختبارات الخلفية والتحسينات، ولن يتغير في التداول الحقيقي أو التجريبي. 

–على الأسعار المفتوحة  RTR Momentum Trend Expertز بيانات النمذجة: باستخدام الأسعار المفتوحة (يتم ترمي
OnBar أو التكتكات المحاكاة المسماة "كل تكتكة" و"كل تكتكة بناءً على التكتكات الحقيقية" تتضمن فارق العرض والطلب ،(()

 دقيقة للبيانات.  1التاريخي للوسيط، وهناك أيضًا خيار شريط 

 " فيها وقتاً أطول بكثير من نمذجة "أسعار الفتح".Real Tickالتي تم تحديد " ملاحظة: ستستغرق الاختبارات الخلفية

 أقترح إجراء التحسينات باستخدام "أسعار الفتح"، ثم تشغيل اختبار رجعي واحد باستخدام "التكتكات الحقيقية".
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START ،STEP ،STOP: 
START.هي القيمة الأولى للإدخال الذي سيتم اختباره ، 

STEP الزيادة، ستضاف إلى القيمة السابقة للإدخال الذي تم اختباره، وستجري اختبارًا جديداً. ، هي 

STOP.هي القيمة الأخيرة من المدخلات التي سيتم اختبارها ، 

 لذلك في هذا المثال، حددنا مدخلاً واحداً فقط للتحسين، وهو عتبة الربح.

 .20، وننتهي عند 2، الخطوة (الزيادة) = 8نبدأ من 

 . 20، 18، 16، 14، 12، 10، 8سنقوم باختبار عتبة الربح عند؛ 

 ). 20إلى  8ممرات (من  7وهناك 

 

  https://www.metatrader5.com/en/terminal/help/algotrading/strategy_optimizationالمصدر: 
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 الوصف والتفسير: EAمدخلات 
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ᢝ  المدخلات

ᡧᣔا ᡨᣂالوصف الاف 

 1234 الرقم السحري
، ᛿لما قمت بتحمᘭله عᣢ مخطط، قم  ᢕᣂشار الخبᙬد للمسᗫᖁمعرف ف

ا من 
᠍
 أرقام 7-6بឝعطائه رقم᠍ا جدᘌد᠍ا مكون

 أدخل الرموز
USDJPY|XAUUSD|NDX|COST|META  

|TSLA|MSFT 

 ᢝᣘعد الرمز، ولا داᗷ "|" ةᗷكتاᗷ نهاᚏلإدخال رموز متعددة، افصل ب
. أدخل " ᢕᣂعد الرمز الأخᗷ ة الرمزᗷتا᜻لCURRENT دᗫᖁإذا كنت ت "

 الرمز الذي ᘌعمل علᘭه المسᙬشار الخبᢕᣂ حالᘭ᠍ا. أو اᜧتب رمز᠍ا واحد᠍ا. 

   الأطر الزمنᘭة

 ᡧ ᢕᣌن زمنيᗫصحيح|خطأ|خطأ|خطأ|خطأ وضع إطار  
|false|false 

"true" أو ᡧ ᢕᣌن زمنيᗫلوضع إطار "false .ةᘭلوضع ثلاثة أطر زمن "
، يتم  ᡧ ᢕᣌن الزمنيᗫوضع الإطار ᢝ

ᡧᣚالأوسط تجاهل ᢝ ᡧᣎالإطار الزم. 

 ᣢأعTF D1|D1|D1|H4|H4|D1|H4 الاتجاه ᣠإ ᢕᣂشᛒ مخطط ᣢأع 

TF المتوسط H4|H2|H4|M20|H1|H3|H1 
ᢝ وضع الإطارᗫن 

ᡧᣚ سᛳالمتوسط، هو للارتداد (ل ᢝ ᡧᣎالإطار الزم
( ᡧ ᢕᣌالزمني 

 ᡧᣍأدTF M15|M15|M15|M5|M5|M5|M5 
ᢝ للتنفᘭذ حᘭث يتم 

ᡧᣎوهو الإطار الزم ، ᢝ
ᡧᣎإطار زم ᡧᣍحسابأد SL  و

TP. 

ᢝ الأرᗖاح
ᡧᣎمضاعف ج 

  

ᢝ  14|14|18|14|10|16|18 عتᘘة الᗖᖁــح ᡧᣎض᠍ا إطار زمᘌــح هو مضاعف لوقف الخسارة، وهناك أᗖᖁمستوى ال
 ᣢالمتحرك لوقف الخسارةأع. 

 الاتجاه
  

الاتجاه:  
 ᢕᣂلͭقصᗫᖔلاهماͭط᛿ 

  طᗫᖔل|᛿لاهما|᛿لاهما|طᗫᖔل|طᗫᖔل
  |طᗫᖔل|طᗫᖔل

ᗫد ᢔᣂمرشح الس 
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 0|0|0|0|0|0 الحد الأقᣕ للانᙬشار
، فلن يتم تنفᘭذ أي صفقات إذا ᛿ان الفرق 0إذا أدخلت رقم᠍ا أᢔᣂᜧ من 

ᢝ نافذة 
ᡧᣚ المعروضMarketWatch  .من الرقم المحدد ᣢأع 

انحراف الدخول 
 (مضاعف الفرق)

 .الحاᢝᣠ  الفارقالانزلاق الأقᣕ المسمᖔح ᗷه هو مضاعف  3

 نᖔع الأمر
  

 أمر السوقͭالحد
  السوق|السوق|السوق|السوق

  |السوق|السوق|السوق

 وضع إدارة المخاطر
  

 عادي إدارة المخاطر

ᙏ ᡧسᘘة المخاطرة عᣢ  -عادي  ᢕᣌل 1مثال: إذا تم تعي᛿ فستخاطر ،
كة التداول، 1صفقة ب سᘘة  ᡫᣃ د الحساب.  وضعᘭمن رص %

كة التداول،  ᡫᣃ لرأس مال ᣕالحد الأق ᣠحاول عدم الوصول إᘭس
ام وضع اختᘘار الرجᖔع والذي ᘌحدده المستخدم. ᘌجب استخد

 ᢝ
ᡧᣚ فقط . ᢝᣙار الرجᘘالاخت 

الحد الأقᣕ لانخفاض 
كة  ᡫᣃ رأس مالProp 

Firm 
ووضع  Prop Firm Liveلا ينطبق عᣢ الوضع العادي ووضع  90

 . ᢝ
ᡧᣛار الخلᘘالاخت 

 حجم اللوت
  

 حجم اللوت الثاᗷت
 

لوت لᝣل صفقة، اضᘘط جميع اللوتات  1.40، عᣢ سᘭᙫل المثال
 ᣢستخدم هذا الوضع.  0الأخرى عᘻ إذا كنت 

 ᙏ 1سᘘة المخاطرة
% من رصᘭد الحساب لᝣل صفقة، 1المخاطرة عᣢ سᘭᙫل المثال، 

 ᣢارات الأخرى عᘭط جميع الخᘘستخدم هذا 0اضᘻ إذا كنت ،
 الوضع. 

 مᘘلغ ثاᗷت ᗷالدولار 
 

دولارات لᝣل صفقة،  110= مخاطرة  110 عᣢ سᘭᙫل المثال،
 ᣢارات الأخرى عᘭط جميع الخᘘستخدم هذا  0اضᘻ إذا كنت

 الوضع. 

   تعليق تداول مخصص
ᢝ الوضع الآمن"عᣢ سᘭᙫل المثال   تعليق مخصص

ᡧᣚ تداولات سارة" 

   إعدادات أمر الحد

تعمل فقط إذا تم تحدᘌد "حد"، والإزاحة ᢝᣦ مضاعف الفارق،  1 تعᗫᖔض الحد
اء ᗷالسعر الحاᢝᣠ مطروح᠍ا منه  ᡫᣄذ حد الᘭتم تنفᚏالفارق. لذلك س 

expiry_hours 12 
ᢝ تᗫᖁد ᘌLIMITعمل فقط إذا تم تحدᘌد  ᡨᣎأن ، وهو عدد الساعات ال

 .سارᗫةأوامر الحد  تظل فيها 

 صحيح  مرشح يوم الأسبᖔع
صفقات  EAتᗫᖁد أن ᘌفتح لا صحيح أو خطأ. "خطأ" إذا كنت أدخل 

 ᡧ ᢕᣌيوم مع ᢝ
ᡧᣚ 

 مرشح ساعة اليوم
  

 واضح  ساعة الᘘدء

ة ᢕᣂواضح 2 الساعة الأخ 

 

 جميع الرموز غير محدودة  RTR Momentum Trendإعدادات رمز واحد لـ 
 USDJPY AUDJPY EURJPY CHFJPY 

 12345 1234 1234 12345 الرقم السحري
الدولار الأمريكي  أدخل الرموز

 مقابل الين الياباني
الدولار الأسترالي 
 مقابل الين الياباني

EURJPY CHFJPY 

     الأطر الزمنية

 صحيح   false خطأ صحيح  وضع إطارين زمنيين
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 TF D1 D1 D1 W1أعلى 
 TF H4 H4 H1 H4متوسط 

 TF M15 M15 M20 H1أدنى 
     مضاعف جني الأرباح

 16 18 14 16 عتبة الربح
     الاتجاه

 طويل طويل طويل طويل الاتجاه: كلاهما/طويل/قصير
     مرشح الانتشار

 0 0 0 0 الحد الأقصى للانتشار
انحراف الدخول (مضاعف 

 السبريد)
3 3 3 3 

     نوع الأمر

 السوق السوق السوق السوق أمر السوق/الحد
     

  ...يمكنك ترك جميع الإعدادات الأخرى كما هي أو تغييرها حسب رغبتك
     
 USDJPY USDJPY XAUUSD NDX 

 12345 1234 1234 123456 الرقم السحري
 USDJPY USDJPY XAUUSD NDX أدخل الرموز
     الأطر الزمنية

 خطأ   false صحيح  صحيح  وضع إطارين زمنيين
 TF W1 D1 D1 D1أعلى 

 TF H4 H4 H2 H4متوسط 
 TF M30 H1 M15 M15أدنى 

     مضاعف جني الأرباح

 10 16 1 17 حد الربح
     الاتجاه

 كلاهما كلاهما طويل طويل الاتجاه: كلاهما/طويل/قصير
     مرشح الانتشار

 0 0 0 0 الحد الأقصى للانتشار
انحراف الدخول (مضاعف 

 السبريد)
3 3 3 3 

     نوع الأمر

 السوق السوق السوق السوق أمر السوق/الحد
     

  ...يمكنك ترك جميع الإعدادات الأخرى كما هي أو تغييرها حسب رغبتك
     
 ADBE ميتا التكلفة MSFT 

 12345 12 12 1234 الرقم السحري
 ADBE COST META MSFT أدخل الرموز
     الأطر الزمنية

 خطأ   false  false  false وضع إطارين زمنيين
 TF D1 H4 H4 H4أعلى 

 TF M20 M20 H1 H1متوسط 
 TF M5 M5 M5 M5أدنى 

     مضاعف جني الأرباح
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 14 18 18 16 حد الربح
     الاتجاه

 طويل طويل طويل طويل الاتجاه: كلاهما/طويل/قصير
     مرشح الانتشار

 0 0 0 0 الحد الأقصى للانتشار
انحراف الدخول (مضاعف 

 السبريد)
3 3 3 3 

     نوع الأمر

 السوق السوق السوق السوق أمر السوق/الحد
     

  ...يمكنك ترك جميع الإعدادات الأخرى كما هي أو تغييرها حسب رغبتك
     
 TSLA NVDA ETH ETH 

 1234 1234 1234 12345 الرقم السحري
 TSLA NVDA ETH ETH أدخل الرموز
     الأطر الزمنية

 خطأ  false  false  false وضع إطارين زمنيين
 TF D1 D1 D1 D1أعلى 

TF متوسط H3 H4 H4 H4 
 TF M5 M5 M Mأدنى 

     مضاعف جني الأرباح

 16 14 18 14 حد الربح
     الاتجاه

 طويل كلاهما طويل طويل الاتجاه: كلاهما/طويل/قصير
     مرشح الانتشار

 0 0 0 0 الحد الأقصى للانتشار
انحراف الدخول (مضاعف 

 السبريد)
3 3 3 3 

     نوع الأمر

 السوق السوق السوق السوق أمر السوق/الحد
     

  ...يمكنك ترك جميع الإعدادات الأخرى كما هي أو تغييرها حسب رغبتك
     
 BTCUSD SOLUSD LTCUSD LNKUSD 

 123456 123456 1234 12345 الرقم السحري
 BTCUSD SOLUSD LTCUSD LNKUSD أدخل الرموز
     الأطر الزمنية

 خطأ   false صحيح   false وضع إطارين زمنيين
 TF D1 D1 D1 D2أعلى 

 TF H1 H3 H1 H3متوسط 
 TF M15 M M20 M15أدنى 

     مضاعف جني الأرباح

 10 16 18 14 حد الربح
     الاتجاه

 طويل طويل طويل طويل الاتجاه: كلاهما/طويل/قصير
     مرشح الانتشار
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 0 0 0 0 الحد الأقصى للانتشار
انحراف الدخول (مضاعف 

 السبريد)
3 3 3 3 

     نوع الأمر

 السوق السوق السوق السوق أمر السوق/الحد
     

  ...يمكنك ترك جميع الإعدادات الأخرى كما هي أو تغييرها حسب رغبتك
     
 DOTUSD    

    12 الرقم السحري

    DOTUSD أدخل الرموز

     الأطر الزمنية

    صحيح  وضع إطارين زمنيين

    TF D1أعلى 

TF متوسط H4    

    TF M15أدنى 

     مضاعف جني الأرباح

     عتبة الربح

     الاتجاه

    طويل الاتجاه: كلاهما/طويل/قصير

     مرشح الانتشار

    0 الانتشار الأقصى

انحراف الدخول (مضاعف 
 الانتشار)

3    

     نوع الأمر

    السوق أمر السوق/الحد
     

  ...يمكنك ترك جميع الإعدادات الأخرى كما هي أو تغييرها حسب رغبتك

 

 الحل! –إصلاح  – 4805خطأ 
 ]srotacidnI::‘\RTR_Trend.ex5’ [4805لا يمكن تحميل المؤشر المخصص  – 4805خطأ 

 

 
 ) (الذاكرة المؤقتة).MT5) وذاكرة التخزين المؤقتة (CPUهذا خطأ يتعلق بوحدة المعالجة المركزية (هذا ليس خطأ في الترميز. 
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هذه المشكلة تحدث فقط مع المستشارات الآلية متعددة الرموز؛ وحدات المعالجة المركزية القديمة، الشرائح القديمة، أجهزة الكمبيوتر 
 جيجابايت. 8التي تقل سعة ذاكرتها عن 

 حيح.يمكن حل هذه المشكلة بسهولة، وبمجرد حلها لن تواجه أي مشكلة لأن ذاكرة التخزين المؤقتة ستتذكر بشكل ص
 ) عند التحميل على مخطط للتداول الحي.2) أداة اختبار الإستراتيجية أو 1يمكن أن يحدث هذا في 
 لكل منهما حلول مختلفة.

  MT5حل أداة اختبار الإستراتيجية ) 1(
 أغلق جميع البرامج التي تعمل على نظام التشغيل (أو أعد تشغيل الكمبيوتر). - 
أن بياناتك تعود إلى ما يكفي من الوقت بالنسبة للرموز والتواريخ المخصصة التي اخترتها.  . تأكد من MT5أعد تشغيل محطة - 

 ; الأشرطة، لعرض بياناتك التاريخية.gt; الرموز &gtاعرض &

 على مخطط حي)  MT5 (EAحل التداول الحي في ) 2(
بالإعدادات  MT5ي برامج أخرى. سيتم فتح ، دون تشغيل أMT5أعد تشغيل جهاز الكمبيوتر/الكمبيوتر المحمول. افتح محطة - 

 .ونريد ذاكرة تخزين مؤقتة جديدة (ذاكرة مؤقتة)الأخيرة التي أغلقت بها، 
 

على ملف > ملفات تعريف > حفظ باسم... > قم بتسمية ملف التعريف الجديد > أغلق جميع الرسوم البيانية > افتح رسمًا بيانيًا جديداً، 
 ط.فق EURUSD ،1سبيل المثال 

 
 للملفات المحافظة)،  H1(أو  M5وأسقطه على الرسم البياني  EAاسحب 

 ; موافقSET&gt; تحميل ملفات gtيجب أن يكون هناك مخطط واحد مفتوح فقط&
 الجديد. EAالآن قم بذلك للرسوم البيانية الأخرى التي تريد إضافتها وتذكر إضافة رقم سحري فريد إلى 

بدون مشاكل،  EAsبتحميل دائمًا وسترى أنها ستقوم  MT5. أعد تشغيل محطة 4805بدون أخطاء  EAsالآن قمت بتحميل جميع 
 وذلك لأن ذاكرة التخزين المؤقتة للملفات الشخصية (الذاكرة المؤقتة) مضبوطة بشكل صحيح!
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